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Supplement for Teach Yourself Visually: Word 2007 by Marmel.  
 
These supplemental materials were created by Joyce Kirst, Professor for Academic 
Development B195, and are not endorsed by the author or publisher of the original 
textbook. They are available in alternate formats through Disabled Student Programs 
and Services in FACE 16, 395-3443 V/TTY. 
 
Chapter 1  
Page 4  
Opening Word 
Note: First launch assistive software (Jaws, ZoomText, etc.) 
Note: ALT + shortcut key activates ribbons and some tools; CTRL + shortcut key 
directly performs some commands without going through a menu or dialog box 
 
Starting Word 
Press ALT + CTRL + W if available or 

1. Windows Key (between CTRL and ALT) or CTRL + ESC for START Menu 
2. P for Programs 
3. M for Microsoft Office 
4. Arrow to Microsoft Office Word 2007 (arrow up to scroll to the bottom of the list) 

 
Exiting Word 

1. ALT+F for the Office Icon or the File Menu 
2. X for Exit 
3. Word will prompt you to save if you haven’t done so 
4. Y for Yes or N for No 

 
Page 6  
Work with Office Button/Icons 
Note: Office icon tasks were formerly under the File Menu (ALT + F) and ALT + F is still 
used to access them. 
 

1. ALT + F for the Office Icon, formerly the File Menu 
2. Arrow down or press the underlined letter to activate a command 
 

Office Icon Command (ALT+F) Underlined Letter Keyboard Shortcut  
without using Office Icon

New N CTRL + N 
Open O CTRL + O 
Save S CTRL + S 
Save As A F12 
Print P CTRL + P 
Prepare E  
Send D  
Publish U  
Close C  
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Options I  
Exit X ALT + F4 
 
Page 7 
Note: Common commands in the Quick Access Toolbar may be directly accessed with 
the keyboard. 
 
Quick Access Toolbar Command Keyboard Shortcut 
Save CTRL + S 
Undo CTRL + Z 
Redo CTRL + Y 
Print CTRL + P 
 
Page 8 
Keyboard shortcuts to the 7 Ribbons in Word 2007 
 
Ribbon Keyboard Shortcut 
Home ALT + H 
Insert ALT + N 
Page Layout ALT + P 
References ALT + S 
Mailings ALT + M 
Review ALT + R 
View ALT + W 
 
Page 9 
Keyboard Shortcuts within the Ribbons 
 
To do this Press 

Select the active tab of the Ribbon and 
activate access keys 

ALT or F10. Press either of these keys 
again to move back to the document and 
cancel the access keys 

Move to another tab of the Ribbon ALT or F10 to select the active tab, then 
Left Arrow or Right Arrow 

Minimize or restore the Ribbon CTRL + F1 
Display the shortcut menu for the selected 
command SHIFT + F10 

Move the focus to select each of the 
following areas of the window in 
succession: Active tab of the Ribbon, View 
status bar at the bottom of the window, 
Your document 

F6 

Move the focus to each command in the 
Ribbon, forward or backward ALT or F10, then TAB or SHIFT + TAB 
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Page 10 
Note: Preview does not work when using keyboard shortcuts. 
 
Page 11 
Note: In any drop down menu, arrow up or down or press the first letter of the item you 
want to go to. 
 
Page 12 
Note: The MiniToolbar fades in and out when you select text. It is not available from the 
keyboard. 
 
The Context or Shortcut Menu pops up when you right click the mouse or press 
SHIFT+F10. Then press a letter or arrow up or down from the keyboard to select a 
command. 
 
Page 13 
Textbook shows an example using the Paragraph Dialog box. This comes from the 
Paragraph Tab of the Page Layout Ribbon:  

1. ALT + P for Page Layout 
2. PG for Paragraph Tab 
3. TAB to move forward to each item in the dialog box or press SHIFT + TAB to 

move backwards within the dialog box.  
4. Press up or down arrow within each item of a dialog box or type an entry 
5. Press TAB or ENTER to select an item and use it in your document 
6. Press ENTER for OK to accept the changes and close the dialog box or press 

ESC for Cancel to close the dialog box without making any changes 
 
Page 17 
 
To move cursor within a document Keyboard Shortcut 
Forward one space or character Right arrow 
Backward one space or character Left arrow 
Up one row Up arrow 
Down one row Down arrow 
Forward one word CTRL + Right arrow 
Backward one word CTRL + Left arrow 
Down one screen’s worth of text Page Down 
Up one screen’s worth of text Page Up 
To beginning of row HOME 
To end of row END 
To beginning of document CTRL + HOME 
To end of document CTRL + END 
To last place you changed text SHIFT + F5 
 
Page 18 
Help = F1 
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Page 19 
To close the Help panel press ALT + F4 
To switch between Help panel and your document, press ALT + TAB 
 
Chapter 2 
Page 22 
 
Save Commands With Office Icon List Direct from Keyboard 
Save ALT + F, S CTRL + S 
Save As ALT + F, A  
 
After  Save As or the first Save, a dialog box will appear. 

1. Save = CTRL + S or Save AS = ALT + F, A 
2. Save In = ALT + I 
3. Arrow to your saving device or file location. Enter 
4. Filename = ALT + N 
5. Type a name for the document 
6. To change type of file, Save As Type = ALT + T 
7. Arrow to Word 97-2003, Enter 
8. Save = ALT + S 

 
Page 25 
Word Options = ALT + F, I 
Use arrows + TAB to navigate dialog box 
 
Page 28 

1. Open = CTRL + O or ALT + F, O 
2. Look In = ALT + I 
3. Arrow to file location, Enter 
4. TAB 3 times to the file list 
5. Spacebar selects the first file in the list 
6. Arrow down to the file you wish to open 
7. Enter or ALT + O to open file 

 
Alternate way to open a recently used file: ALT + F, right arrow to list of recent files, 
arrow down to the file you wish to open. Enter. 
 
Page 32 
New = CTRL + N or ALT + F, N, Enter for New Blank Document 
Tip: Save (or save and close) any open documents before starting a new document 
 
Page 34 
Switch between open documents and programs = ALT + TAB 
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Page 39 
Close a document = ALT + F, C 
Tip: You may be prompted to save. Choose Y for Yes or N for No. 
 
Chapter 3 
Editing text: See separate Set-up Handout and table below 
 
Command Keyboard Shortcut 
Align Right CTRL + R 
Align Center CTRL + E 
Bold CTRL + B 
Underline CTRL + U 
Align Left CTRL + L 
Align Justify CTRL + J 
Indent TAB 
Double Space CTRL + 2 
Save CTRL + S 
Print CTRL + P 
Exit ALT + F, X 
 
Page 53 
To delete a block of text, first select text, Shift + Arrows, or to select a word at a time, 
SHIFT + CTRL + Arrow. Then press delete or backspace to erase the selected text. 
 
Page 55 
Undo = CTRL + Z 
Redo = CTRL + Y 
 
Page 60 
To Move text: 

1. Select text (Shift + arrow) 
2. Cut = CTRL + X 
3. Move cursor to new location 
4. Paste = CTRL + V 

To Copy text: 
1. Select text (Shift + arrow) 
2. Copy = CTRL + C 
3. Move cursor to new location 
4. Paste = CTRL + V 

Tip: You may cut, copy or paste with the Mini Toolbar:  
1. Select text 
2. Right Click or SHIFT + F10 
3. Arrow to Cut or Copy 
4. Enter 
5. Move cursor to new location 
6. Right Click or SHIFT + F10 
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7. Arrow down to Paste 
8. Enter 

 
 
Page 62 
Switch between documents = ALT + TAB 
 
Page 64 
 
View Ribbon Commands Keyboard Shortcuts 
View Ribbon ALT + W 
Print Layout View P 
Full Screen Reading F 
Web Layout L 
Outline U 
Draft E 
Document Map VM 
Expand Sub-headings denoted with + Right arrow 
Hide sub-headings denoted with - Left arrow 
Thumbnails H 
Zoom Q – Use TAB & arrows, Enter for OK 
 
Chapter 4 
Page 84 
Toggle Ribbon/Status Bar = F6  
Right arrow to access each item in status bar 
Note: For Word Count and other data, Right Click or SHIFT + F10 on Status Bar item 
called “Words” 
Alternate way to get Word Count List = CTRL + SHIFT + G 
 
Page 90  
Quick Spell Check: Right Click or SHIFT + F10, Arrow to correction, press Enter   
Note: Grammar Check feature is turned OFF at the Disabled Student Programs and 
Services Accommodations Desk when students use computers for exams.  
 
Spelling Commands Keyboard Shortcuts 
Full Spell Check F7 
Full Spell Check in Review Ribbon ALT + R, S 
Error in context ALT + : 
Suggestions ALT + N 
Ignore once ALT + I 
Ignore all ALT + G 
Add to dictionary (Don’t use at BC) ALT + A 
Change ALT + C 
Change All ALT + L 
Close Enter 
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Page 94 
Quick synonym list – Right click or SHIFT + F10 on a word. Arrow down to Synonyms. 
Right arrow. Arrow through list. Press Enter to select a synonym to replace the word in 
your document. 
 
Thesaurus Commands Keyboard Shortcuts 
Full Thesaurus SHIFT + F7 
Full Thesaurus from Review Ribbon ALT + R, E 
Toggle focus between document & 
thesaurus pane 

F6 

To move forward through sections of 
thesaurus pane 

TAB  

To move backward to sections of 
thesaurus pane 

SHIFT + TAB 

For  meanings and word  choices Arrow up and down 
To select a word  Right click or SHIFT + F10 
Insert word ALT + I 
Copy word into memory ALT + C 
Look up word from list ALT + L 
 
Chapter 5 
Page 108 
Font Changes 

1. Select text or make changes before typing 
2. Right click or SHIFT + F10 
3. F or arrow to Font. Enter 
4. TAB and arrow through dialog box 
5. Enter to make changes and close dialog box 

 
Font Commands Keyboard Shortcuts 
Font Dialog Box CTRL + D 
Font Size CTRL + SHIFT + P, type size or arrow, enter 
Increase Font Size 1 Point CTRL + ] 
Decrease Font Size 1 Point CTRL + [ 
Home Ribbon for Font Changes ALT + H 
Font Name ALT + H, FF 
Font Size ALT + H, FS 
Increase Font Size to Next Set Size ALT + H, FG 
Decrease Font Size to Next Set Size ALT + H, FK 
Font Color ALT + H, FC 
Bold CTRL + B or ALT + H, 1 
Italics CTRL + I or ALT + H, 2 
Underline CTRL + U or ALT + H, 3 
Normal (no bold, italic, or underline) CTRL + SHIFT + N 
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Page 115 
To copy text formatting: 

1. Move cursor to text containing formatting you want to copy 
2. Copy format = CTRL + SHIFT + C 
3. Select text to which you want to apply the formatting (SHIFT + arrow) 
4. Past format = CTRL + SHIFT + V 

 
Chapter 6 
Page122 
Note: You do not need to select text before changing alignment unless you want to alter 
more than one paragraph at a time. 
 
Alignment Commands With Home Ribbon Direct from the Keyboard 
Align Left ALT + H, AL CTRL + L 
Align Center ALT + H, AC CTRL + E 
Align Right ALT + H, AR CTRL + R 
Justify ALT + H, AJ CTRL + J 
 
Page 123 
Note: Default line spacing in Microsoft Office Word 2007 is 1.15, not 1.0 as it was in 
Word 2003. 
 
Line Spacing Commands With Home Ribbon Direct from the Keyboard 
Single Spacing ALT + H, K, Enter CTRL + 1 
Double Space ALT + H, K, Arrow down CTRL + 2 
1.5 Space ALT + H, K, Arrow down CTRL + 5 
Other Spacing ALT + H or ALT + P, PG, 

ALT + N  
 

 
Page 124 
To set line spacing between paragraphs, go to the Paragraph Dialog Box through the 
Paragraph Tab on either the Home or Page Layout Ribbons: 

1. Home Ribbon = ALT + H or Page Layout Ribbon = ALT + P 
2. Paragraph Tab = PG 
3. Spacing Before a Paragraph = ALT + B 
4. Spacing After a Paragraph = ALT + F 
5. Type a number, for example 12 for 12 points worth of space 
6. Press TAB or Enter  

 
Shortcut: Page Layout Ribbon = ALT + P, Spacing Before = SB or Spacing After = SA, 
type a number referring to the number of points for desired spacing, press Enter. 
 
Page 126 – Bulleted or Numbered List  
Notes: In a Bulleted or Numbered List, press Enter after each item to create a new 
bullet or number in the sequence. For sub-items, press TAB; to return to the primary 
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items, press SHIFT + TAB.  To stop a list, press Enter twice. Numbers are used when 
order matters. You may re-order items by dragging them or using cut and paste. 
 
Bullet List:  

1. Home Ribbon = ALT + H 
2. Bullet List = U 
3. Right arrow to select first bullet style 
4. Enter 
5. Type the first item 
6. Press Enter 
7. Type the next item 
8. After the last item, press Enter twice to stop the bullets 

 
Numbered List: 

1. Type the number one, press period, spacebar.  
2. Or use the Home Ribbon = ALT + H, Numbered List = N  
3. Type the first item. Enter. 
4. Type the next item.  
5. Enter twice after the last item to stop the number list. 

 
Chapter 7 
Page 154 - Margins 
 
To change Margins: 

1. Page Layout Ribbon = ALT + P 
2. Arrow down to the Margin setting of your choice 
3. Or press ALT + A for Custom Margins 
4. Type a Margin setting for Top, Bottom, LEFT, and Right. TAB to each Margin 

setting box and type a number (in inches). 
5. If you do not Apply to “Whole Document” (ALT + Y), you must change the default 

setting in the Layout Tab (ALT + L), Section Start (ALT + R) from “New Page” to 
“Continuous”. 

 
Page 164 – Page Numbers 
 
To insert page numbers: 

1. Insert Tab = ALT + N 
2. Page Number = NU 
3. Select a Location (T=Top of Page, B=Bottom of Page, P=Page Margins, 

C=Current Position) 
4. Right arrow, then arrow down to a setting 
5. Enter  
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Page 186 – Newspaper Columns 
 
To format your document or a portion of a document into columns: 

1. Place your cursor before text or area to be changed into columns, or select text 
to be changed into columns.  

2. Page Layout Tab = ALT + P 
3. Columns = J 
4. Arrow down to select one, two, etc., 
5. Or press C for More Columns to customize columns in a dialog box 
6. Enter 

 
Chapter 8 
Page 192 
 
Print = CTRL + P 
Print from Office Icon = ALT + F, P 
TAB to various options in the dialog box 
Enter for OK to send document to the printer 
 
Chapter 9  
Page 202 – Table 
 
To insert a table: 

1. Place cursor in your document where you want to insert a table 
2. Insert Ribbon = ALT + N 
3. Table = T 
4. Insert Table = I 
5. Type the number of columns, TAB 
6. Type the number of rows. Enter 
7. Type text for the first cell: row one, column one 
8. Press TAB to move to the next cell: row one, column two 
9. The cursor will move down to row two when no more columns are available in the 

current row.  
10. To add a new row, place your cursor at the end of the last row and press TAB. 
11. To move cursor below the table, place your cursor at the end of the last row and 

press right arrow, then Enter. 
 
Chapter 10 
Page 230 – WordArt 
 
To add WordArt 

1. Place cursor in your document where you want to insert WordArt 
2. Insert Ribbon = ALT + N 
3. WordArt = W 
4. Arrow right and down to the style of WordArt you wish to use. Press Enter. 
5. Type text for the WordArt 



Supplement for Teach Yourself Visually Word 2007.doc Page 11 of 12 

6. Font change = ALT + F, up or down arrow, Enter 
7. Size change = ALT + S, up or down arrow, Enter 
8. Bold or Italic = CTRL + B or CTRL + I 
9. Enter for OK 
10. To move cursor away from the WordArt, press Right arrow  

 
Page 232 – Picture 
 
To add a Picture from a file: 

1. Place cursor in your document where you want to insert a picture from a file 
2. Insert Ribbon = ALT + N 
3. Picture = P 
4. Locate the picture file. Look In = ALT + I 
5. Arrow to the drive or folder with the picture file. Enter 
6. TAB 3 times to the file list 
7. Press spacebar to activate the first file in the list. If it is a folder containing files, 

press Enter to open the folder to its contents 
8. Arrow to the picture file of your choice 
9. Press Enter to place the picture file in your document 
10. To resize a file proportionately, change only the height or width; Word will adjust 

the other measurement automatically.  
a. Select picture if it is not already selected: SHIFT + Arrow. 
b. Picture Tools Format = ALT + JP 
c. Height = H, or Width = W. 
d. Type a number in inches. Word will add the quotation mark denoting 

inches. Press Enter 
11. To move cursor below picture, press Right Arrow, then Enter 

 
Page 234 – ClipArt 
 
To add ClipArt: 

1. Place cursor in your document where you want to insert ClipArt 
2. Insert Ribbon = ALT + N 
3. ClipArt = F 
4. The ClipArt Panel opens on the right. To toggle between the ClipArt Panel and 

your document, Press F6 
5. TAB down to “Organize Clips”. You may be prompted to Organize Now or Later. 

Press N for Now 
6. Press F6 to activate the Collection List 
7. Arrow down to Office Collections, Web Collections, or another collection list 
8. Right Arrow expands sub-menus. Arrow up and down through the category list. 
9. Press F6 to toggle between the category list and the list of files within each 

category. 
10. Right Arrow through the clipart files within a category 
11. To choose a file from the list use the Context Menu, SHIFT + F10 
12. Arrow down to Copy. Enter 
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13. Switch back to your document from the ClipArt window with ALT + TAB or to 
close the ClipArt window and return to your document press ALT + F4 

14. Paste = CTRL + V 
15. To resize a clipart image proportionately, change only the height or width; Word 

will adjust the other measurement automatically.  
a. Select the clipart image if it is not already selected: SHIFT + Arrow. 
b. Picture Tools Format = ALT + JP 
c. Height = H, or Width = W. 
d. Type a number in inches. Word will add the quotation mark denoting 

inches. Press Enter 
16. To move cursor below the clipart image, press Right Arrow, then Enter 
17. To delete a picture or clipart image, Select the item SHIFT + arrow, press Delete. 

 
 


